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All information and specifications written or implied in 

this manual are current at the time of release.  However, 

due to the ongoing process of adding improvements to the 

product, PowerTronics / Eastern Time Designs, Inc. 

reserves the right to make changes at any time without 

notice. 

 

 

Copyright 2009 
PowerTronics 

EASTERN TIME DESIGNS, INC.  

SAFETY NOTICE  
 

The power cable attached to the device is 

supplied with a safety and reference ground.  Do 

not use the PQR 2020 when powered from an 

ungrounded outlet. 

 

High voltage exists at many points inside the 

cabinet.  Qualified personnel ONLY! should 

open the covers. Opening the covers may affect 

the warranty. 
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18 MONTH WARRANTY  

Eastern Time Designs, Inc. (PowerTronics) warrants to the original retail purchaser 

that each PQR Series 2020 Power Line Monitor sold by PowerTronics or any 

authorized representative is free from defects in material and workmanship for 18 

MONTHS from the date of purchase. 

In the event of malfunction or other indication of failure attributable directly to 

faulty workmanship and/or materials, Eastern Time Designs, Inc. (PowerTronics) will 

at its option, repair or replace the defective product, to whatever extent it shall deem 

necessary to restore the product to proper operating condition, provided the purchaser 

includes proof of the date of purchase of the product along with the defective product. 

Please note that Eastern Time Designs, Inc. may replace the defective product with 

a new or re-manufactured functionally equivalent product of equal value. 

When returning a product for repair, be sure to include the customer's mailing 

address, email address and telephone number . Products should be returned to: 

 

PowerTronics 

Attention: CUSTOMER SERVICE DEPARTMENT  

143 Raymond Rd. 

Candia, NH 03034 

During the first 18 months after the date of purchase all labor and materials will be 

provided without charge. There will be no warranty for either parts or labor after the 

expiration of 18 months from the date of purchase. 

The customer shall be solely responsible for the failure of any Eastern Time 

Designs product or component thereof resulting from accident, abuse or misapplication 

of the product, and Eastern Time Designs assumes no liability as a consequence of 

such events under the terms of this warranty. Some states do not allow the exclusion of 

implied warranties, so the above exclusion may not apply to you. This warranty gives 

you specific legal rights and you may also have other rights which vary from state to 

state. 
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INTRODUCTION  
This reference guide is designed to aid users of the PQR 2020 in the interpretation of AC power 

line problems. 

The PQR 2020 Power Line Monitor is made in the U.S.A. by PowerTronics.  This unit 

incorporates the latest technology in surface mount assembled circuit boards to provide the user with 

detailed information describing the power line.  It will detect a wide range of disturbances including 

dropouts, power failures, sags, surges, impulses, high frequency noise, and common mode noise on 

the three phases of AC voltage and the Neutral line.  The PQR 2020 monitors these disturbances and 

records them, along with a data log of channel readings at user selected intervals, in non-volatile 

FLASH RAM for future access. 

Electronic equipment is damaged more often by power 

disturbances than by fire, theft, and vandalism combined. 

Intermittent power problems are the most expensive, hidden cost to 

the owners of microprocessor-based equipment. It is therefore 

essential that power supplies be properly tested to insure that no 

such damage occurs. 

The PQR 2020 is easy to use and provides immediate and long-

term information for the technician and customer to understand 

power line disturbances. It is an important tool for installers of 

electronic equipment, service technicians, medical facilitiesô technicians, or anyone that needs to 

identify the power quality of a particular site. 

The PQR 2020 is one of a series of practical power line monitors, designed and priced to be 

outfitted to everyone who services or installs three-phase electrical and electronic equipment.  We 

believe that the PQR 2020 Power Line Monitor is one of the most cost effective and practical power 

line monitors on the market. Look for more advanced diagnostic products from PowerTronics 

(Eastern Time Designs, Inc.) in the near future. 

To monitor the three phases of AC line voltage with the PQR 2020, connect the test leads 

between the circuits to be tested and the three phase  and Neutral inputs located on the back of the 

unit.  Then plug the power cord provided with the unit into a standard 110 volt or 220 volt outlet.  

After running an internal self test, the unit will start testing the three phases and the Neutral  lines.  It 

is recommended that the unit test the three phase power source for at least a 24 to 72 hour period. 

After testing is completed simply attach the PQR 2020 to a computer to access the data via USB 

or RS232 serial communications.  The summary, detail, and data log reports can then be examined 

and used in the rendering of graphics using the PowerTronics PQR Host Communications Software 

or a similar terminal emulation software. 
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CALIBRATION  
 

The PowerTronics Power Quality Recorders are designed to test the Power Line with a 

high degree of accuracy. In this unit all measurements are referenced to a state of the art, 

temperature compensated voltage source. It is recommended that each unit be calibrated 

annually by the factory as certain components may require periodic calibration. The 

procedure typically takes seven days and will be provided upon request for a nominal fee. 

 

Mention CALIBRATION PROCEDURE when calling for an RMA number. 
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OVERVIEWOVERVIEWOVERVIEW    

The PQR 2020 Power Line Monitor is a state of the art, fully integrated instrument which 

measures, records, and reports power disturbances, aiding in the analysis of power quality for 

Three Phase AC power in medical, commercial, and industrial applications. 

Power disturbances detected on multiple 

channels are recorded by their time, date, and 

magnitude in non-volatile FLASH RAM 

memory.  This data is then retrieved from the 

PQR through its serial communications port. 

The PQR 2020 continuously data logs the 

voltages on the three AC Phases and Neutral 

line.  This data is then stored in memory, 

independent of the disturbances.  The unit's Data 

Logger will log these readings at the interval 

length selected by the user. 

 

Connections to the PQR 2020 are 

made between the safety connectors on 

the back of the unit and the circuit 

being tested.  The power to operate the 

unit comes from any 110/220 volt, 

15/20 amp AC power supply.  Once 

plugged in, the PQR 2020 immediately 

begins testing the signals on the testing 

inputs.  The unit comes equipped with a 

power cord for plugging into a standard 

110 volt, 15/20 amp AC outlet.  

Adapter cables (or Patch Cords) are 

available from PowerTronics in order 

to allow the unit to be powered off of 

other style, voltage, and/or amperage 

outlets.  The unit may also be powered 

by DC voltages of 9 to 24 volts 

Graphics SoftwareGraphics SoftwareGraphics Software   IncludedIncludedIncluded!!!    
 

The 

PQR HostPQR HostPQR Host   

CommunicationsCommunicationsCommunications   

SoftwareSoftwareSoftware   

is provided with the 

PQR 2020PQR 2020PQR 2020   

 
Software Features: 

§ Download data from the PowerTronics PQR Series monitors 

§ Generate Summary Report PIE CHARTS  of disturbances 

§ Create Detail Report HISTOGRAMS  of all events detected 

§ Plot Data Log LINE CHARTS  of the Channel Readings 
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MMMONITORONITORONITOR    3 P3 P3 PHASEHASEHASE   AC PAC PAC POWEROWEROWER   
(Three Phase + Neutral AC Line Voltage)(Three Phase + Neutral AC Line Voltage)(Three Phase + Neutral AC Line Voltage)   

FEATURES 

§ User-Friendly 

§ Minimal Setup Time 

§ Made in the USA 

§ Eighteen Month Warranty 

§ Non-Volatile Memory 
(Flash RAM - 20 year Data Retention 

Guaranteed at 125º C without power) 

§ Multi Phase Monitoring 

§ Continuous Data Logging of AC Voltages 

(3 Phases + Neutral) 

§ Continuous Disturbance Detection on all four AC 

Voltage inputs 

§ Programmable Sampling Rates and Disturbance 

Thresholds 

§ Fast Impulse Detection 

§ Serial Communications port for easy connection 

to a Computer or Terminal 

§ Easy to Understand Reports 

§ Comes complete with Communications and 

Graphics Software designed for the unit 

Simple to operate: 

- Connect the test leads to a service 

panel and the unit 

- Plug the power cord into a 

grounded outlet 

- Periodically connect to the unit to 

a computer for reports 

Stores events in non-volatile Flash RAM: 

- Over 32,000 Total Events recorded! 

- Stores over 32,000 Data Log Entries! 

(or one data log reading every minute for over 

22 days) 

Measure all types of Power 

Disturbances: 

§ Dropouts 

§ Power Failures 

§ Sags 

§ Surges 

§ Impulses 

§ High Frequency Noise 

§ Common Mode Noise 

§ Frequency/Phase Deviations 
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SIGNAL TESTING  
Power Up Procedure 

Applying AC Power 

The main power to operate the unit comes from any standard 110/220 volt, 15/20 amp AC voltage 

supply provided through the AC connector located at the back of the unit.  The unit comes equipped 

with a power cord for powering off of a 120 volt, 15 or 20 amp outlet. 

When the PQR 2020 is first connected to AC power (110 V AC or 220 V AC), it will go through 

a series of power on diagnostics.  The status of these tests can be seen in the Unit Status LED.  As 

soon as the diagnostics have completed, the PQR 2020 is on-line and monitoring the input channels.  

Simply leave the PQR 2020 plugged in with the voltages to be tested attached to the three AC input 

channels and the Neutral channel as will be described in the following pages. 

After testing connect the PQR 2020 to a PC using a null modem cable attached to the USB or 

RS232 serial communications port.  The PowerTronics PQR Host Communications Software (or a 

similar program) can then be used to download all the necessary data from the unit and render the 

text-based reports into graphical presentation formats 

Applying DC Power (optional) 

The PQR 2020 has a DC Power Input connector for running off a DC power supply.  The most 

common use of this power option is for allowing the unit to continue functioning off battery power 

even after a massive power failure has hit the test site.  The connection is made using a standard 

Female DC Connector with outer/inner diameters of 5.5/2.1 mm.  The outer shell must have the 

positive voltage.  Note that when using the DC power supply option it is essential that the AC power 

cord still be attached as it supplies the safety and reference ground.  The source can be 9 to 24 V DC. 

Unit Status LED 

The Unit Status LED is located on the front panel of the PQR 2020.  It indicates system 

diagnostics status and Channel operational status. 

While the initial tests are being executed (approximately 15 seconds) the LED will blink.  After 

the tests are completed, it will turn off briefly, and then turn on steady.  The LED will also blink for 

fifteen seconds whenever a disturbance is detected on any input or the serial port has been accessed. 

 

The recommended testing time is 24 to 72 hours in order to determine the suitability of an outlet 

for powering electronic equipment. 
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Testing AC Voltages - Connecting 

The PQR 2020 Three Phase Voltage Power Line Monitor is designed to obtain the maximum 

amount of useful data from the circuits under test, while requiring the minimum amount of setup 

time.  It is capable of analyzing the power on Three Phases and a Neutral channel of AC voltage. 

All signals to be tested are applied to the four test input banana jacks located on the back of the 

PQR 2020.  There is one jack for each phase and one for the Neutral.  The phases are applied to the 

Red Jacks while the Black Jack is reserved for Neutral.  Data from the four input connector starts 

being collected as soon as power is applied to the AC power connector (or alternate DC power 

connector) located on the back of the unit. Data will continue to be gathered until the unit is 

unplugged.  Note that all signals are referenced to the safety ground of the unit.  The unit MUST have 

this safety ground.  (Plugging the PQR 2020 into a grounded outlet using the supplied AC Power 

Cord will take care of this.) 

To test one or more of the AC phase lines simply connect the supplied PowerTronics Test Leads 

between the PQR 2020 input jacks and the Service Panel using the following procedure: 

¶ Connect the Safety Banana Plug of the Black Test Lead to the Black 

Neutral input jack on the back of the PQR 2020 

¶ Connect the Alligator Clip of the Black Test Lead to the NEUTRAL BAR  

on the Service Panel 

¶ Connect the Safety Banana Plug of a Black Test Lead to the Black Phase 1 
input jack on the back of the PQR 2020 

¶ Connect the Alligator Clip of the Black Test Lead to the first phase to be 

tested on the Service Panel.  USE CARE!!!  

¶ Follow the same procedure for Phases 2 and 3 if so desired.  USE CARE!!!  

DANGER! HIGH VOLTAGE!  
 

The Voltages you are testing can KILL!  

Only a Certified Electrician  

can connect the test leads to a distribution panel. 

 

Please use Care! 
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Testing AC Voltages - Monitoring  

Long term voltage recording is known as Data Logging.  The PQR 2020 samples the voltage on 

each of the 4 AC inputs continuously and stores the average readings once each minute (or at the 

sampling interval the Data Logger is set to).  There is enough data storage capacity in the unit to 

collect over 32,000 of these readings.  When the Data Logger is set to one minute intervals this is 

equivalent to over 22 days of voltage readings on all four channels. 

The PQR 2020 will continuously test the three phase voltage inputs and Neutral line for Dropouts, 

Power Failures, Sags, Surges, Impulses, High Frequency Noise, and changes in Line Frequency and 

Phase.  Any power quality problems that exceed the preset thresholds will be recorded in the Flash 

RAM, with the time and date stamp of the event.  There is enough data storage capacity in the unit to 

collect over 32,000 disturbance events total between all 4 channels. 

 

Additional information with regards to the data storage and event detection capabilities for the 

four AC Voltage testing channels of the PQR 2020 is supplied in the Specifications Section of this 

manual. 
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SERIAL COMMUNICATIONS  

Connecting to the PQR 2020 

DIRECT:  

The serial port connector on the front panel of the PQR 2020 is a 9 pin DB style RS232. The pinout 

is as follows: 
 

Pin 2 Receive Data 

Pin 3 Transmit Data 

Pin 5 Ground 
 

A Null modem cable must be used to establish a connection between this port and a PC. This type 

of cable connects the Transmit Data pin on the PC to the Receive Data pin on the PQR, and the 

Transmit Data pin on the PQR to the Receive Data pin on the PC. It also connects the Ground pins 

together. 

The PQR 2020 is configured to operate at 19,200 baud (factory default), with 8 data bits, 1 stop bit, 

and no parity checking. Select Xon/Xoff Communications protocol. 

MODEM:  

Use a straight cable (not a null modem) when connecting to a modem. 

Power the PQR 2020 and the Modem up at the same time after connecting the cable.  The PQR 

2020 will auto configure the Hayse compatible Modem for auto answer mode, at 19,200 baud (or 

present baud rate setting). If the modem is not Hayse compatible, configure it to answer the phone 

on 2 rings, with a Baud rate of 19,200 (or current setting), 8 data bits, 1 stop bit, and no parity 

checking. 

COMMUNICATIONS SOFTWARE:  

The PQR Series 2020 can communicate with a PC using programs such as the PowerTronics PQR 

Host Communications Software and HyperTerminal.  Note that such programs will provide a 

means of directly downloading the data in a text file format. This data can then be employed by the 

user in the generation of graphical plots and charts as needed.  The PQR Host Communications 

Software is specially designed to facilitate the easy creation of these graphical representations of 

the data gathered by the PQR 2020.  The following pages will deal with its installation and use.  

Discussion will also be made about more general commands useable through basic 

communications programs such as HyperTerminal. 
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PQR Host Communications Software 

Introduction:  

This section of the manual is designed to aid PQR users in the use of the PowerTronics PQR Host 

Communications Software available with their unit in order to maximize the ease of the interpretation 

of AC and DC power line disturbances as well as environmental problems. 

The PQR Host Communications Software is designed to work with the PQR Series of Power Line 

Monitors, which are portable diagnostic instruments designed to monitor AC and DC Power Lines, 

analyze and capture disturbances, and record these disturbances for later retrieval. The PQR Host 

Communications Software is also capable of working with other PowerTronics product lines such as 

the PDL Series Data Loggers and units in the DETECTIVE SERIES line that have been designed and/or 

modified for Windows compatibility. See the PowerTronics Product Support page for the most recent 

list of PowerTronics units that are supported by the PQR Host Communications Software. 

Made in the U.S.A. by PowerTronics, the PQR Series Monitors incorporate the latest technology 

in their surface mount assembled circuit boards to provide the user with detailed information 

describing all types of power line and environmental disturbances. Once detected, the PQR Series 

monitors will record the most important information about these events, such as the event type, the 

event magnitude, the time and date of the occurrence, and the channel it occurred on. This 

information is stored in FLASH RAM, where it is formatted into an easily read format that may be 

downloaded to your computer for display or printing. This format is also designed to be used directly 

with the PowerTronics PQR Host Communications Software. 

When testing a power site, it is recommended that you test the power source for a period of at 

least 72 hours. After testing, attach the PQR Series monitor to your computer through the serial 

communications port on the unit, start the PQR Host Communications Software program, and scroll 

through the list of functions to choose the report or display you need. 

The PQR Host software program will provide you with a listing of disturbances and channel 

readings in summary, detail, or data log form. The disturbances are recorded as individual events 

which are analyzed according to their magnitude, time, date, and channel. The Data Log of each 

channel can also be displayed on your computer monitor or printed to a local printer. In addition, the 

Data Log data can be zoomed in on using the PQR Host Software to highlight any areas of concern. 
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Software Overview: 

The PowerTronics PQR Host Communications Software is provided with the PQR 2020.  When 

the PQR 2020 is connected to a computer via a null modem cable, the PQR Host Software provides 

several functions to the user: 

§ Automatically connects to the PQR 2020 

§ Allows the user to configure the Settings of the PQR 2020 

§ Downloads data from the PQR 2020 and saves it directly to the computer 

§ Generates Reports, Charts, and Graphs from the downloaded data 

(Note that not all functions of the PQR Host Software are available to every unit.) 
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Installation Procedure: 

Go to www.PowerTronics.com, click on the support link, and download the latest version of the 

software or place the Software Installation CD provided with your unit into the CD drive on your 

computer. 

Select or Double click on the SETUP file.  A series of installation setup files will then be copied 

to your computerôs memory.  The installation program will then initiate the installation and display a 

window with the following: 

To prevent any software conflicts, you should close any other applications or programs running 

before continuing with the PQR Host Communications Software installation.  Then click the OK  

button depicted in the window above. 

Note that the installation processes can be terminated at any time simply by pressing the Exit 

Setup button.  The installation software will then confirm that the user wishes to abort the installation 

procedure and will then proceed to delete the installation setup files previously placed on the system.  

The user will be notified upon completion of these tasks. 
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To proceed directly to the installation and use the default directory for the destination of the 

software, simply click on the Computer Icon button shown in the above window image.  

Alternatively, selecting the Change Directory will allow the user to choice the desired location on 

the computer system for the software installation.  Once an alternate location has been specified 

simply press the Computer Icon to proceed.  Note that the location that will be used for installation 

is shown to the left of the Change Directory button. 

Once the user has selected the OK  button the installation software will proceed to the destination 

directory window depicted below. 

The installation program will then 

proceed to the window shown on the left. 

This stage allows the user to select the 

Program Group under which the software 

will be placed.  By default, the installation 

software uses the PowerTronics Group.  

Click on another to change to that group. 

When complete click Continue.  This 

will allow the Software to be installed.  The 

installation program will notify the user 

once the installation procedure has been 

successfully completed. 

The PQR Software can be uninstalled 

using the Add or Remove Programs utility.  
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Accessing the Software: 

Now that the PowerTronics PQR Host Communications Software has been successfully installed, 

the program can be used to communicate with the PQR Series units and to provide graphical analysis 

of the gathered data. 

Note that to facilitate speedy access of the PQR Host Software a shortcut can be created on the 

desktop.  This is accomplished by right clicking on the PQRHost from the above listing.  Select the 

COPY command and then PASTE to the desktop.  This icon can now be used to start the PQR Host 

Software in addition to the method described above. 

 

The following pages will outline the use of the software to communicate with the unit and analyze 

the data transmitted. 

To run the PQR Host Software: 

Click on the START button 

Select Programs 

Select POWERTRONICS 

(Assuming default grouping was used in installation) 

Select PQRHost from the list 
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Operating the PQR Host Software: 

The PowerTronics PQR Host Communications Software is a graphical interface, Windows-based 

program.  The main tasks in the operation of the software are performed through the use of pull-down 

menus located at the top of the main window.  The following provides a summary of these menus 

which are described in more detail on the following pages. 

File 

The File menu contains options for 

using data files that are stored on the 

computer hard drive or a disk. 

Edit  

In the Edit menu are some of the 

standard text editing options.  Only 

available when a text report is open. 

View 

The View menu provides items used to 

control what tools are visible and 

available to the user in the main program 

window.  These items can aid the user in 

the operation of the PQR Host Software. 

Settings 

The Settings menu contains items that allow the user to specify certain settings for communication 

between the software and the PQR device.  The menu also provides an interface for setting the 

internal PQR device parameters. 

Communications 

The Communications menu contains items that allow the user to retrieve data from the device.  It 

also allows for the clearing of the unit and checking for proper channel operation.  Along with the 

Graph menu, the Communications menu composes the core of the PQR Host Software. 

Graph 

The Graph menu lists the graphical representation options available to the user for the creation of 

plots and charts based on the data contained in the active data file.  Only the graphing options that 

are valid for the active data window will be displayed. 

Help 

The Help menu provides an in-program help for the user concerning the operation of the software.  

In addition, the Help menu provides important information with regards to the software version. 

The screen shown here is the starting point for working with 

the units in the PQR Series.  Note that not all menus described 

above are shown as they become available at certain times - 

such as Graph menu appears only when a text report is open. 
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File Menu: 

The File menu contains options for using data files stored on the computerôs hard drive or a disk. 

Open 

Select the Open menu item to open a data 

log, detail report, or summary report that 

is stored on the computerôs hard drive or a 

disk from a previous download.  After 

specifying the desired file, the program 

will open a window that contains the data 

from the file.  Note that the file type must 

also be selected. 
 

This function can also be performed at any 

time by using the Open File command on 

the Quick Launch Toolbar. 

Close 

Select the Close menu item to close the active device data or graphical display window. 

Save 

Select the Save menu item to save the active data file to it current file name and location.  This 

function also can be performed by using the Save File command on the Quick Launch Toolbar. 

Save As... 

Select the Save As menu item to save the active data file to a new file name and location 

specified by the user. 

Print  

Select the Print  option to send the present active window to a printer.  The selection of this 

menu item will cause a Print Dialog to be displayed for the user to select which printer to use 

and to specify the desired settings.  This function also has an icon in the Quick Launch Toolbar. 

Memory Files 

This program will keep track of the last four files that have been used, and keep their names and 

locations in memory.  To reopen any of these files, simply select the menu item with the desired 

fileôs name.  The program will display the contents of the file in a new window. 

Exit  

Select the Exit  menu item to close all windows and exit the program. 


